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Student Instruction Manual 

The interactive 3D companion exercises for this book are available in two 3D CAD formats: Trimble SketchUp’s SKP and 

Autodesk AutoCAD’s DWG. Both formats can be imported into a variety of 3D modeling software and these exercises can 

be completed using those (with some reduction in functionality if SketchUp is not used). However, instructions here will 

be provided for the freely available SketchUp (Make and online) software. You are encouraged to use it for these 

exercises to get the full benefits of included labels, dimensions and some of the interactive behavior. SketchUp is easy to 

learn and can be used even by novices.  

You can download SketchUp Make for free (Windows and Mac versions are available) from here: 

http://sketchup.com/ 

These exercises will also work with SketchUp Pro, which can be purchased at a student discount and might already be 

available in your university’s computer labs. 

After installing the software and starting it, you should see the following screen (Windows/Pro version shown) and you are 

ready to start the exercises: 

 

Alternatively, you can use the online, browser-based my.SketchUp.com application, which has a similar tool set to 

SketchUp Make. Sign up for it here: 

https://my.sketchup.com/app 

After registering and starting the my.SketchUp.com app, it should appear in the browser window as shown below: 

http://sketchup.com/
https://my.sketchup.com/app
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Use the Insert File tool (see red arrow) to insert a (previously downloaded) SketchUp SKP file into the model area. 

Please note that this file is being inserted as a Component (everything in it is grouped). To be able to commence with the 

exercise, you first need to un-group the inserted model. You do that by right clicking on the inserted model and then 

selecting Explode from the context menu (as shown below). At that point, you are ready to start the exercise. 

 

Please note: All SketchUp SKP files are provided in the 2013 file format and can be used in SketchUp version 2013 and 

newer. 
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Tools 

Although SketchUp has much more functionality than is shown on this startup screen, you can complete all of the 

exercises using only the tools that are provided on the Getting Started toolbar. These tools are: 

 

(left to right: Select, Erase, Line, Arc, Rectangle, Push/Pull, Offset, Move/Copy, Rotate/Copy, Scale, Measure, Label, Paint, 

Orbit, Pan, Zoom, Zoom-Extents, 3D Warehouse, Extension Warehouse, Export to LayOut) 

If you are new to SketchUp, make sure the Instructor window is open (as shown above). It is located in the panel on the 

right side of the work area and provides contextual help for the currently open tool. You can always display this window by 

going to Window > Default Tray > Instructor. 

Please note: All of these tools are also available on my.SketchUp.com although icons may look slightly different. 

The only tools from this toolbar that you need for these exercises are explained next: 

Select 

Click select or hit the spacebar to be able to select objects. Single-click objects to select them or draw a selection rectangle 

around multiple objects (window and crossing selection are available). 

Please note: If you double-click an object, you will get into group/component editing mode. It looks like this: 

 

When this happens, click outside of the object into empty space to exit edit mode. You do not need to use this functionality 

for the exercises. 

Erase 

If you need to erase something, start this tool and click an edge of the object you need to erase. 

Alternatively, you can select one or multiple objects first and then hit the delete key on your keyboard. 
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Move 

You will need to move and copy things a lot in these exercises, therefore get familiar with this tool. To move an object, 

start the tool and click a convenient point on the object (e.g. a corner or the midpoint of a side). Always use SketchUp’s 

snap functionality to pick this point and the target point. Don’t just eye click points and distances – things will not line up 

in the end. 

When you temporarily move an object parallel to one of the main axes (red/green/blue), SketchUp will show you this (see 

image below) and you just need to type a distance (e.g. 3’2” for three feet and two inches) to move the object by this 

amount in the shown direction. 

 

SketchUp has an excellent inference system that allows you to acquire points easily in 3D. Check out its help file to learn 

more about this. 

Copy 

The Copy tool is actually hidden inside the Move tool. To use it, all you need to do is start the Move tool and toggle the 

copy functionality by clicking the Ctrl key (you don’t even have to hold that key, just use it as an on/off switch!). You can 

then move the copied item and place it where you like it. Remember to use object snapping here, too. 

If you need to make multiple, regularly spaced copies (an “array”), place the first copy (left arrow in the image below) and 

immediately type x4 (or any number you like) to make the remaining copies. This works very well for objects like bricks. 

Just remember that you need to enter “x4” before you click anything else in the software (you need to still be in the 

Move/Copy tool). 
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Rotate 

When you start the rotate tool, you get a protractor-like gizmo. Based on what is underneath your cursor, this tool will pick 

a plane about which it will rotate (also indicated by its color). The point you click then will be the center of rotation. 

 

To select a specific plane to rotate about, hover your mouse where the tool acquires that plane (e.g. above the ground) and 

then hold the shift key to lock this plane until you pick the center of rotation. This allows you to perform rotations about 

arbitrary planes. 

As with the copy tool, use the snap functionality to acquire endpoints, midpoints etc. 

Next you will need to pick a zero line for the rotation. Move the mouse along an object (e.g. the bottom line of the brick 

shown above) to set this line. 

You can then move into the direction of the rotation and either click a point or type in a value for an angle. 

By the way: rotational copies and rotational arrays work similar to the Move tool! 
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Scale 

When you need to stretch things, use the Scale tool. Click the appropriate yellow handle to start stretching in a certain 

direction. Although you can enter a scale factor (e.g. 2 to double the size of an object), It is also possible to start stretching 

and then acquire a relative point (e.g. the next brick’s corner) to stretch to that point. 

For these exercises, you typically only need to stretch lengthwise, therefore make sure you select the respective yellow box 

in the center of a side. 

 

Measure 

The Measure tool gives you a means to check your work. In addition, it also lets you place construction points (e.g. on 

edges) that you can later use e.g. as references for copying. With this tool you can also create offset reference lines (click on 

a line instead of a point to do that). Enter values for precise distances. 
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Some General SketchUp Tips 

 Never click the Measurements box (shown in the bottom-right corner of your screen): 

 

If you need to enter something (e.g. a distance) , just type on the keyboard and it will appear here. 

 Every once in a while you need to “look through” objects to e.g. snap onto hidden points. Turn on X-ray mode to 

do this (View > Face style > X-ray). 

 Sometimes it is easier to work in parallel projection instead of perspective mode. You can switch between the two 

using the Camera menu. Please note: If you run into clipping problems (parts of the model disappear), click the 

Zoom-Extents button. 

 SketchUp lets you snap in length increments. This is usually 1/16” unless you change the default settings in 

Window > Model Info. 

 It’s a good idea to review SketchUp’s object snap and inference documentation here: 

http://help.sketchup.com/en/article/3000083 

 If you want to manipulate many objects at the same time (e.g. move a brick course), then it might be useful to 

group these objects. Select them and select Make Group from the right-click menu. 

Need More Info? 

These pages should get you going quickly with the software. However, if you want to know more about SketchUp, take a 

look at Alexander Schreyer’s book “Architectural Design with SketchUp: 3D Modeling, Extensions, BIM, 

Rendering, Making, and Scripting, 2nd Edition”: 

http://www.wiley.com/WileyCDA/WileyTitle/productCd-1118978811.html 

 

http://help.sketchup.com/en/article/3000083
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Chapter 1 

1-19 - Lay out a subdivision 

 

Chapter 5 

5-2 - Softwood cells 
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5-3 - Hardwood cells 

 

 

5-21, 5-26, 5-34 - Produce a glulam, I-joist, CLT panel 
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Chapter 6 

6-10 - Concrete block wall with opening 

 

 

6-27 - Intricate bond using modular bricks 
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6-27 - Typical bonds using modular bricks 

 

 

6-30 - Masonry window opening detail 
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6-36 - Chimney-top detail 

 

 

6-42 - Ashlar patterns 
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Chapter 7 

7-20 - Concrete rebar for a simple beam 

 

Chapter 9 

9-15 - Formwork for a wall using wood products 

 

 

  



Fundamentals of Residential Construction, 4th Edition 

Index of Interactive 3D Exercises 

by Alexander C. Schreyer, University of Massachusetts, 2016 – p.8 

 

9-20 - ICF Foundation wall 

 

 

9-23 - CMU Foundation wall 
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Chapter 10 

10-2 - House section assembly 

 

 

10-2 - Wood framing foundation wall floor 
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10-7 - Frame a cantilever floor 

 

 

10-16 - Floor with stair opening 
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10-30 - Window opening framing 

 

 

10-33 - Advanced Framing 
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10-45 – Stair 

 

 

10-48 - Interactive stair sizing 
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Chapter 11 

11-13 - Frame a hip valley roof 

 

 

11-29 - Frame a Dormer 
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Chapter 12 

12-37 - Eave detail 

 

 

12-47 - Green roof detail 
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Chapter 14 

14-8, 14-18 - Various siding on exterior corner 

 

 

14-27 - Brick siding on wood frame wall 
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Chapter 18 

18-20 - Wall insulation and electrical 

 

Chapter 19 

19-2 Add cavity insulation 
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Chapter 20 

20-18 - Drywall and wood flooring 

 

 

20-30 - Corner tiling detail 
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Chapter 21 

21-11 Install kitchen cabinets 

 

 

21-24 Attach window trim 

 

  



Fundamentals of Residential Construction, 4th Edition 

Index of Interactive 3D Exercises 

by Alexander C. Schreyer, University of Massachusetts, 2016 – p.19 

Chapter 22 

22-6 - Paving patterns 

 

 

22-19 - Deck construction 
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Chapter 23 

23-8 - A panelized house 

 

 

23-22 - A SIPs house 
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23-39 - A modular house 

 

Chapter 24 

24-4 - Bent assembly 
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24-10 - Pegged-bracing connection 

 

 

24-13 - Timberframe assembly 
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Chapter 26 

26-4 - Light-gauge foundation floor and wall 

 

 

26-4 - Light-gauge roof and wall 

 

 


